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ArcMap has the tools you need to create and edit your spatial data. With
ArcMap you can create and edit features in shapefiles or a geodatabase.
ArcView licensed seats of ArcMap allow you to create a temporary map
topology so you can simultaneously edit features that share geometry across
multiple feature classes. With ArcEditor or ArcInfo licensed seats of
ArcMap, you also have access to advanced editing tools, geometric network
editing, and geodatabase topology editing and management.
The easiest way to learn how to edit in ArcMap is to complete the exercises
in this tutorial. Most of these tutorials can be completed with ArcView seats
of ArcMap�the exceptions are the geodatabase topology exercises.
Exercises 1 and 2 introduce the edit sketch, sketch tools, and edit tasks and
show you how to use them to create new features quickly and easily.
Exercise 3 walks you through the process of converting features on a paper
map directly into your database using a digitizing tablet.
Exercise 4 teaches you how to move, rotate, scale, extend, trim, and modify
the vertices of existing features.
Exercise 5 shows you how to create and maintain the shared boundaries
between features and layers with a map topology.
Exercise 6 demonstrates how you can integrate layers from CAD drawings
into your database.
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Exercise 7 shows you how to clean up existing data and
create new features that share boundaries between features
and layers with a geodatabase topology.
Exercise 8 shows you how to use the Spatial Adjustment
tool to transform, rubbersheet, and edgematch your data.
Exercise 9 teaches you how to use the Attribute Transfer
tool to transfer the attributes from one feature to another.
Exercise 10 teaches you how to convert labels to
annotation in a geodatabase, place unplaced annotation
features, and edit annotation features.
Each of these exercises takes between 15 and 20 minutes to
complete. You have the option of working through the
entire tutorial or completing each exercise, one at a time.
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Exercise 1: Creating polygon features

The editing tools in ArcMap make it easy to create new
features. You use edit tasks, the edit sketch, sketch tools,
and snapping to create new features in ArcMap.
In this exercise, you will digitize a new polygon feature
into a shapefile layer that outlines a land use study region.
The study area polygon that you create needs to snap to an
index grid layer that subdivides the entire geographic
region. You will begin by starting ArcMap and loading a
map document that contains the shapefile layer and a
geodatabase that contains the index grid for the region.

Starting ArcMap and beginning editing

Before you can complete the tasks in this tutorial, you must
start ArcMap and load the tutorial data.
1. Double-click a shortcut installed on your desktop or use

the Programs list in your Start menu to start ArcMap.
2. Click the Open button on the Standard toolbar. Navigate

to the CreatingNewFeatures.mxd map document in the
Editor directory where you installed the tutorial data
(C:\ArcGIS\ArcTutor is the default location). Click the
map and click Open.

3. Click the Editor Toolbar button on the Standard toolbar
to add the Editor toolbar to ArcMap.

4. Click the Editor menu and click Start Editing.
If you only have one workspace in your map, you can start
editing the map layers at this point. In this exercise, two
workspaces are loaded in the map, so you will need to
choose the workspace you want to edit.
5. Click the Editor folder workspace to start editing the

studyarea.shp shapefile. Click OK. You will edit the
geodatabase in the next exercise.

2

5

3



4 EDITING GIS FEATURES TUTORIAL

Creating a new polygon feature

This exercise focuses on creating a new study area polygon
that encompasses a parcel CAD drawing. The extent of the
study area is defined by the index grid lines located in an
existing database. The index grid represents logical
divisions within the data.
To create the new polygon, you must do heads-up
digitizing against the index grid and snap the vertices of
your new polygon to the vertices of the grid lines.

Setting the snapping environment

Before you start editing the study area shapefile, you need
to set your snapping environment so each point you add
snaps to the vertices of features in the index grid.
1. Click the Editor menu and click Snapping to display the

Snapping Environment dialog box.

2. Check the Vertex check box next to the IndexGrid layer
to snap the sketch vertices to the vertices of the index
grid. Close the Snapping Environment dialog box.

With the snapping environment set, you can create a
new study area polygon. Make sure you snap each point
to the thick index grid lines shown below.

2

1
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Setting the current task

Before you start digitizing a new feature, you must set the
current editing task to Create New Feature.
1. Click the Task drop-down arrow and click Create New

Feature.

To create a new feature, you also need a target layer. The
target layer determines the type of feature you will create
and in which layer it will be stored. Since there is only one
shapefile in the folder that you started to edit, the target
layer is set to the study area shapefile by default.

Using the Sketch tool

To create a new feature using the Create New Feature task,
you must first create an edit sketch. An edit sketch is a
shape that you draw by digitizing vertices using the sketch
construction tools located on the tool palette.
Several tools can add vertices to the sketch. You will use
the Sketch tool to add the study area polygon.

1. Click the tool palette drop-down arrow and click the
Sketch tool.

2. Click to add the first vertex of the sketch to the lower
left corner of the thick index grid lines. The vertex
should snap in place.

3. Click to add the remaining vertices, snapping each
vertex to a corner in the index grid. Create vertices
counterclockwise until you return to the point located
directly above the first vertex that you placed.

1

1
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Finishing the sketch

1. Press the F2 key or right-click and click Finish Sketch.
This action adds the final sketch segment and creates
the new feature.

Your new study area polygon is now created. If you
snapped each sketch vertex properly, the new polygon
should look like the shaded polygon below.

Adding attributes

The new feature you created does not contain any attribute
information. Because other polygon features are present in
this shapefile, distinguish your new polygon from the
others by adding descriptive information about it.
You can add descriptive information for a selected feature
using the Attributes dialog box.
1. Click the Attributes button on the Editor toolbar to add a

description attribute to the new study area polygon.

2. Click the layer field for the selected feature and type
�StudyArea� as a description of the feature.

1

2

1
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Saving your edits

After you have created the new study area polygon, you
can choose to save or discard your edits by stopping the
edit session.
1. Click the Editor menu and click Stop Editing.
2. Click Yes to save the new study area polygon into the

study area shapefile you were editing or No to discard
your edits.

In this exercise you learned how to quickly and accurately
create a new polygon feature. You used the Sketch tool to
digitize a polygon shape while snapping each vertex to an
existing vertex in another layer.
There are several other ways you can construct new
features in your GIS database. The next exercise will show
you some of the more advanced methods of constructing
vertices in the edit sketch.
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Exercise 2: Creating line features

In this exercise, you will update your database with a new
road casing line.
In building the line feature, you will learn how to use some
of the more advanced construction methods offered with
the Sketch tool context menu.

Editing the geodatabase

Because the road feature class exists inside a different
workspace than the study area shapefile, you need to start
editing the database before you can create the new line.
1. Click the Editor menu and click Start Editing. Choose

the file geodatabase as the workspace you want to edit
and click OK.

Locating the update area

Spatial bookmarks are named extents that can be saved in
map documents. Creating a bookmark for areas you visit
frequently will save you time.

You will now zoom to a spatial bookmark created for this
exercise.
1. Click the View menu, point to Bookmarks, then click

Update road casings to set the current view to the edit
area of this exercise.

When the display refreshes, note that the top line of this
road casing is missing from the layer. You must update
the road casing by adding the missing line.

1

1
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Setting the snapping environment

The endpoints of the road casing feature need to snap to
adjacent casings to ensure that the new feature is connected
to the existing casing features. Snapping to the end of road
casing lines will help you do this.
1. Click the Editor menu and click Snapping. Check the

End option for the RoadCasings layer to set snapping to
the endpoint of casing features. Uncheck any other
boxes that may still be checked and close the dialog
box.

Digitizing

After setting the snapping environment, make sure the
target layer is set to the RoadCasings layer. Now you can
start digitizing.
1. Click the tool palette drop-down arrow and click the

Sketch tool.

2. Move the pointer to the broken section of the road
casing in the top left corner of the canvas. Once the

Beginning construction

With the first vertex of the new road casing properly
placed, you can construct the casing line feature. Your new
feature will be connected to that casing.

Setting length and angle measurements

Before creating the second vertex, you must first set the
length of the line.
1. Right-click the map and click Length.

1

1

1

pointer is inside the snapping tolerance, the snapping
location (blue dot) will jump to the vertex. Click the left
mouse button to add the first vertex.
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2. Type a value of 15 map units and press Enter.

If you move the pointer now, notice that you can�t stretch
the line further than your length measurement. This is
called a constraint.
You must also set an angle constraint to create the second
vertex.
3. Press Ctrl+A and type a value of 260 degrees. Press

Enter.

Creating a curve tangent to the last segment

You will add a curve that is tangent to the last segment you
added to the sketch. The curve will form the corner of the
road casing.
1. Right-click and click Tangent Curve to enter the curve

information required to place the next vertex.
2. Click the first drop-down arrow and click Chord. Type

�20� to set the chord length. Click the second drop-
down arrow and click Delta Angle. Type �90� in the
second text box for the angle measurement. Click Left
to indicate that the new curve will be tangent to the left
of the previous segment. Press Enter to create the curve.

Creating a vertex relative to the last vertex

Often, construction points are calculated relative to the last
point recorded. Using the Delta X, Y sketch constructor,
you can add relative vertices.
1. Press Ctrl+D. Type �88� for the x-value and �-9� for the

y-value. Press Enter to add the point.

Creating a vertex parallel to an existing line

You can define the angle measurement for points added to
the sketch in several ways. You can set an absolute value as
you did in the first step of this exercise, or you can use the
angles of existing features. Quite often, road casings are
constructed using the angles of road centerlines. Since you
already have one road casing, you can use its angle in
constructing the next segment.

2

13

2
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Creating a tangent curve

One final tangent curve needs to be added to the sketch
before you can connect it to the existing casing and add the
feature.
1. Right-click and click Tangent Curve. Type a chord

length of 12 and a delta angle of 120, then press Enter to
create the final curve segment.

Finishing the sketch

To finish the sketch and create the feature so it is connected
to the existing casing, you need to snap the last point of the
sketch to the endpoint of the existing road casing.

1. Right-click the lower road casing line. Click Parallel.
Press Ctrl+L, type a value of 415, then press Enter.

Creating a new vertex using absolute coordinates

Exact x and y coordinate information is often available for
the construction of vertices. Add the next vertex by typing
exact coordinates using the Absolute X, Y constructor.
1. Right-click the map and click Absolute X, Y. Type

�1227820.6� in the x field, press the Tab key, and type
�181460.6� in the y field. Press Enter to add the point.

1

1
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1. Move the pointer to the endpoint of the existing road
casing until it snaps. Double-click to add the last point
and create the feature.

With construction now complete, you can continue to
search the layer to find additional broken lines and connect
them together, experimenting with these and other sketch
tools and construction techniques. You can save your edits
and the map document if you want.
The next exercise will show you how you can use the
construction methods demonstrated in this exercise to
capture features from a paper map directly into your GIS
layers using a digitizing tablet.
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The first exercise in this chapter showed you how to heads-
up digitize features by snapping to an existing vector
source. However, often that source information is in paper
form. ArcMap lets you trace over the features you are
interested in capturing using a digitizing tablet connected
to your computer. By digitizing data using a tablet, you can
get features from almost any paper map into your GIS
database.

Setting up your digitizing tablet

Before you can start digitizing, you must set up your tablet
and prepare the map from which you want to digitize
features. To use a digitizing tablet with ArcMap, it must
have WinTab�-compliant digitizer driver software. To find
out if a WinTab-compliant driver is available for your
digitizer, see the documentation that came with the tablet or
contact the manufacturer.
After installing the driver software, use the WinTab
manager setup program to configure the buttons on your
digitizer puck. One puck button should be configured to
perform a left mouse click to digitize point features and
vertices; another button should be configured to perform a
left double-click to finish digitizing line or polygon
features. You may also want to configure a button to
perform a right-click so you can access context menus.
If you installed ArcMap before installing your digitizer, the
Digitizer tab may not appear in the Editing Options dialog
box. To add the tab, you must register the ArcMap
digitizer.dll file. To learn how to register digitizer.dll and to
find more information on digitizing, see the ArcGIS
Desktop Help.

Exercise 3: Using a digitizing tablet

Preparing the map

You will now print the paper map from which you want to
digitize and attach it to your tablet.
1. Print the DigitizingFeatures.tif image located in the

Editor tutorial directory where you installed the tutorial
data. The default installation path is
C:\ArcGIS\ArcTutor\Editor\ExerciseData\Digitizing.

2. Attach the paper map to your digitizing tablet using
masking tape, drafting tape, or a special residue-free
putty. Drafting tape looks like masking tape, but leaves
less residue when it�s removed.

3. Start ArcMap if you haven�t already done so.
4. Open the DigitizingFeatures.mxd map document so you

can register the paper map to your map document.

Registering your map for the first time

You must always register your paper map before you can
begin digitizing from it. This involves establishing control
points to register the paper map to the geographic space of
your GIS data. If your map has a grid or a set of known
ground points, you can use these as your control points. If
not, choose four to 10 distinctive locations and mark them
on your map with a pencil. Give each location a unique
number and write down its actual ground coordinates.
Control points can also be saved to and loaded from x,y
coordinates stored in a comma-delimited text file.
In this exercise, the control points and their ground
coordinates are identified for you on the paper map.
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1. Click Editor and click Start Editing.

2. Click Editor and click Options.
3. Click the Digitizer tab. You will create and store control

points here. The control points you add will be saved
with the map document.

1

2

3

4. In the upper left corner of your paper map, locate the
point marked Control Pt.1 and click it using the digitizer
puck.
A record appears in the X Digitizer and Y Digitizer
columns for the control point you digitized.

5. Working clockwise, click each of the three other control
points on your paper map.

6. Type the actual ground x,y coordinates for the first point
(labeled X = 711907 and Y = 943420 on the paper map)
in the X Map and Y Map fields.

6. Continue typing the actual ground coordinates for the
other points in the X Map and Y Map fields.
An error in map units is displayed for each control
point. 

4 6
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7. After you have digitized all the control points and typed
their actual ground coordinates, the total root mean
square (RMS) error is calculated and displayed in map
and digitizer units. Your X and Y Digitizer and error
values may be different from the ones in this example.

To maintain highly accurate data, your RMS error should
be less than 0.004 digitizer units (often inches) or the
equivalent scaled distance in map units�the ground units
in which the coordinates are stored. The map units for this
dataset are meters. You can see what the map units are and
set the onscreen display units by clicking View, Data Frame
Properties, then the General tab of the Data Frame
Properties dialog box.
You can redigitize control points by selecting the point you
want to replace from the list, then clicking your paper map
to capture a new control point. Redigitizing points with
large error values can help reduce the total RMS error.

7

8

2

1

8. Click Apply to accept the registration after you have
reached an acceptable RMS error.

Digitizing modes

You need to enable digitizing mode once you have
registered your map. Enabling digitizing mode maps the
location of the puck on the tablet to a specific location on
the screen.
1. Check the Enabled box on the Digitizer tab of the

Editing Options dialog box to enable digitizing mode.
2. Click OK.
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1

Setting the current task and target layer

Creating new features using a digitizer puck is identical to
creating new features using the mouse. You must set the
current task and target layer before you start digitizing.
1. Click the Task drop-down arrow and click Create New

Feature.

2. Click the Target layer drop-down arrow and click
Lotlines to set the target layer.

Creating new features

There are two ways to digitize features: point mode
digitizing and stream mode digitizing (streaming). You can
toggle between point and stream mode by pressing the F8
key or by right-clicking with the Sketch tool active and
clicking Streaming from the menu. Point and stream mode
digitizing are available either when you�re using a
digitizing tablet or when you�re digitizing onscreen with
your mouse.
Point mode is the default and most common method of
digitizing features that are on paper maps. In point mode,
you convert a feature on a paper map by digitizing a series

2

1

Digitizing new features

You are now ready to begin digitizing new features. You
will add new lot lines representing a new parcel
subdivision into an existing shapefile of lot lines.

To get a better view of the area you�ll digitize in, you�ll
zoom to a spatial bookmark that has been defined for you.
1. Click View, point to Bookmarks, and click Paper Map.

The map zooms to the area of your paper map.
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of points, or vertices. ArcMap then connects the vertices to
create a digital feature. You generally use point mode when
precise digitizing is required�for example, when
digitizing a perfectly straight line.
Stream mode digitizing provides a quick and easy way to
capture features on a paper map when you don�t require as
much precision or when you�re digitizing smooth, curved
lines�for example, rivers, streams, and contour lines. With
stream mode, you create the first vertex of the feature and
trace over the rest of the feature with the digitizer puck.
When you�re finished tracing, you use the puck to complete
the feature.
As you stream, ArcMap automatically adds vertices at an
interval you specify; this interval, expressed in current map
units, is called the stream tolerance. You can change the
stream tolerance at any time, even while you�re in the
process of digitizing a feature.

Digitizing in point mode

1. Click Editor and click Snapping.

1

2. Check the Edge box for the Lotlines layer so the
features you digitize snap to existing edges. Close the
Snapping Environment dialog box.

3. Click the Sketch tool.

3

2
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4

Digitizing in stream mode

When tracing line or polygon features, you may want to
add vertices as you move the mouse rather than clicking
each time you want to add a vertex. Stream mode digitizing
lets you do this.
Before starting to digitize in stream mode, you need to set a
stream tolerance�the interval at which the sketch adds
vertices along the feature you are digitizing. The default
tolerance value is 0 map units, so if you don�t enter a
tolerance value, you may find vertices that overlap each
other.
You will also specify the group tolerance�the number of
streaming vertices you want to group together. The number
you set tells ArcMap how many vertices to delete when you
click the Undo button. For example, if you set this number
to 20 and click the Undo button while you�re digitizing a
feature, ArcMap deletes the last 20 digitized vertices from
your feature.

The lines you are going to digitize now are the exterior
boundary lot lines. These lines are drawn in blue.

4. Using the puck, click the upper leftmost point of the
exterior boundary lot line to start digitizing. You�ll
notice that the pointer snaps to the edges of the lot lines.

For straight segments, you should add a vertex where lot
lines intersect. In curved segments, you should click more
points to make sure their shapes are defined.

5. When you�re done with your sketch, finish it by clicking
the button on your puck that you configured as a double-
click.
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You are now going to digitize the frontage lot lines�the
lines drawn in red�that define the road leading into the
new subdivision. You will digitize these lot lines as two
features, one for the outer line and one for the inner line.

1. Click Editor and click Options.

4

2

3

2. Click the General tab.

3. Type a stream tolerance value of 25 map units and set
the group tolerance to 20.

4. Click OK.
5. Click the Sketch tool.

5

Start here to digitize the first line.

Start here to digitize the second line.

1
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6

6. Snap the pointer to the upper leftmost point of the outer
frontage lot line, but don�t click yet.

7. Press F8 to start digitizing in stream mode.
8. Click to start the sketch.
9. Carefully trace along the boundary of the lots until you

reach the last lot in the upper right. Notice that vertices
are added at consistent intervals that are 25 map units
apart. Although you�re working in stream mode, you can
still click when you want to add a point by hand.

If you make a mistake while streaming, you can click the
Undo button to remove the last 20 vertices. You�ll need to
press F8 to suspend streaming while you�re choosing
interface elements, and press F8 again when you want to
return to stream mode digitizing.

10. Snap the last vertex of your line to the existing lot line
and finish the sketch by clicking the button on your
puck that you configured as a double-click.

Now you are going to digitize the second red line, the inner
frontage lot line.
11. Snap the pointer to the existing lot line and click to start

digitizing the inner frontage line. You should still be in
streaming mode, but if you find yourself in point mode,
press F8 to switch to streaming.

12. Carefully trace along the boundary of the lots until you
reach the last lot in the upper rightmost point of the
inner frontage line.

13. Snap the pointer to the existing lot line and press F8 to
stop digitizing in stream mode.

W

Undo will delete 20 vertices—the number set in
the group tolerance—at a time.
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1

2

3

14. Finish the sketch by clicking the button on your puck
that you configured as a double-click.

With the exterior boundary lines and the outer and inner
frontage lot lines digitized, use point mode to digitize the
remaining line features that define the lots.
Once you�ve digitized all the new lot lines, your map
should look like this:

Disabling the puck

After you�re finished digitizing, you should disable the
digitizer puck.
1. Click Editor and click Options.

2. Click the Digitizer tab and uncheck Enabled to disable
the digitizer.

3. Click OK.
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1

Finishing your digitizing session

Once you have finished tracing lot lines and have disabled
the digitizer puck, you can stop editing and complete the
exercise by saving your edits.
1. Click Editor and click Stop Editing.

2. Click Yes to save your edits.

In this exercise you learned how to create new features in
your GIS database by digitizing shapes directly from a
digitizing tablet. The next exercise will show you how to
copy shapes from existing vector sources�CAD drawing
layers�and paste them into your GIS database.

2

If you need to find out if ArcMap supports your digitizing
tablet, consult the ESRI Web site at www.esri.com for the
most recent information.
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Exercise 4: Editing features

In the first three exercises, you learned how to create new
features in ArcMap. In this exercise, you�ll learn how to
copy and paste, move, rotate, scale, and extend existing
features.

Opening the exercise document and starting an
edit session

1. Start ArcMap.
2. Click the Open button on the Standard toolbar. Navigate

to the EditingFeatures.mxd map document located in the
Editor directory where you installed the tutorial data
(C:\ArcGIS\ArcTutor is the default location).

3. Click the Editor menu and click Start Editing.

Copying and pasting features

When creating vector features of the same type as existing
ones, it is more efficient to copy their shapes than to
digitize over the top of them. You can copy the shapes of
any vector feature that you can select in ArcMap. In this
step, you will select buildings from a CAD drawing and
paste them into a geodatabase layer of buildings.
1. Click the Edit tool on the Editor toolbar and drag a box

around all the new building features to select them.

The selected CAD features should be highlighted as
shown below.

2

3

1
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2. Click the Copy button on the Standard toolbar to copy
the selected features to the clipboard.

3. Set the Buildings layer as the target layer so you can
paste the copied features into it.

4. Click Paste to copy the selected building features into
the target layer. The progress bar will update as each
feature is copied into the target layer.

It is important to note that only the shapes are copied
from the CAD file into the geodatabase. If you need to
paste the attributes as well, you must use the object
loader. Exercise 6 of this chapter shows you how to do
this.

Rotating features

Now that you�ve copied the building features into the
Buildings layer of your geodatabase, you need to orient the
features to fit the parcel subdivision into which you�ll
move them.
1. To avoid selecting features from the CAD layer�called

New Buildings�uncheck it in the table of contents to
hide its features.

2. Click the Rotate tool on the Editor toolbar.

3. Press the A key, type �180�, and press Enter to rotate the
selected building features 180 degrees.
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The selected features are now oriented 180 degrees from
their previous location.

Moving features

Now that the buildings are oriented properly, you are ready
to move and scale them so that they fit inside the
subdivision located near the bottom center of the map.

You can ensure the proper relocation of the building
features by snapping the lower left selected building
feature to the endpoint of the lower left water service line,
shown in red.

1. With the buildings selected, click the Editor menu and
click Snapping.

2. Check the End option for the Water layer and the Vertex
option for the Buildings layer so you can snap the
corner of a building feature to the endpoint of a
waterline. Close the dialog box.

3. Click the Edit tool so you can move the selection anchor
for selected features.
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The selection anchor is a small x located at the center of
selected features. It is the point on the feature or group
of features that will be snapped when you move them.

4. Hold down the Ctrl key and move the pointer over the
selection anchor. When the pointer icon changes, click
and drag the selection anchor until it snaps to the corner
of the lower left building.

5. Drag the selected buildings until they snap to the
endpoint of the waterline.

Notice that some of the buildings are too large to fit
inside the parcels. You must scale these features to make
them fit.

Scaling features

When data is created using a coordinate system different
from that of your database, you may need to adjust the
projection and scale of the data to fit the projection and
scale of your database. Often, simply moving, rotating, and
scaling those features are sufficient.
Because scaling is not a common operation, the Scale tool
is not located on the Editor toolbar. You must, therefore,
add it to the toolbar before you can use it.
1. Click the Tools menu and click Customize.

2. Click the Commands tab and click Editor in the
Categories list. The Editor category contains many
editing tools, regardless of their location.
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3. Scroll down the list of commands on the right until you
find the Scale tool. Drag and drop the tool next to the
Rotate tool on the Editor toolbar. Click Close on the
Customize dialog box.

4. Before scaling the selected features, you may want to
zoom in so that your scaling is more accurate. Click the
Selection menu and click Zoom To Selected Features.

5. Click the Scale tool and drag the selected building
features to scale them. Shrink the features until they fit
inside the parcel subdivisions. Use the waterlines as a
guide. Scale features until the lower right building
matches the endpoint of the waterline.

Extending and trimming waterlines using the
Extend/Trim Features task

Now that you have scaled the building features to fit inside
the parcel subdivision, you need to extend the waterlines so
that they snap to the side of each building. You can extend
and trim waterlines using the Extend/Trim Features task.
1. To get a better view of the waterline that you need to

extend, you can zoom in to the Extend Water Line
bookmark. Click the View menu, point to Bookmarks,
and click Extend Water Line.

2. Click the Task drop-down arrow and click Extend/Trim
Features to set the edit task.
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3. The Extend/Trim edit task will extend selected polyline
features to the sketch you digitize. Click the Edit tool
and click the waterline feature that you need to extend.

4. Click the Sketch tool and snap the first sketch point to
the upper right corner of the building feature to which
you want to extend the water line feature.

5. Move the pointer until it snaps to the upper left building
corner and double-click to finish the sketch. The
waterline will then extend until it intersects the line that
you have digitized. Since the line is identical to the side
of the building, the end of the waterline should snap to
the building.

You can also use the Extend/Trim Features task to cut a
waterline feature if it extends too far into the building.

6. To get a better view of the waterlines, you must zoom to
the bookmarked extent called Trim Water Line, which
was created for you. Click the View menu, point to
Bookmarks, and click Trim Water Line.

7. Click the Edit tool and click to select the waterline that
extends into the building and needs to be trimmed.

8. If you changed the current task, make sure you change it
back to Extend/Trim Features, then click the Sketch tool
to start digitizing.

6
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9. Snap the first sketch point to the lower left corner of the
building feature.

10. Move the pointer to the upper left corner of the
building. Double-click to snap the last point of the
sketch to the building corner and trim the waterline
feature.

Extending and trimming waterlines using the
Modify Features task

The Extend/Trim Features task lets you extend and trim
selected waterlines using a sketch that the features either
cross or extend to. However, that is not the only method for
extending or trimming waterlines. You can move, insert, or
remove vertices of the waterline by making its shape the
edit sketch. You can do this using the Modify Features task.
1. To get a better view of the waterlines, you need to zoom

to the bookmarked extent called Modify Water Line.
Click the View menu, point to Bookmarks, and click
Modify Water Line.

1
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2. Click the Edit tool and click to select the waterline
feature that needs to be extended.

3. Click the Task drop-down arrow and click Modify
Feature to display the vertices of the waterline.

4. Click the Edit tool and move the pointer over the red
vertex at the end of the waterline. Drag the vertex until
it snaps to the building corner.

5. Move the pointer over the red vertex, right-click, then
click Finish Sketch to finish modifying the waterline.

You can follow the same steps to trim line features using
the Modify Features task. You can use the Trim command
to reduce the length of the sketch by an exact distance as
well.
With modifications to these waterlines completed, continue
modifying the rest of the waterlines that don�t connect to
building features and experiment with other methods of
modifying shapes.

5
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Exercise 5: Editing adjacent features with a map topology

Many vector datasets contain features that share geometry.
Features can share edges�for example, line segments�or
nodes, the points at the ends of segments. For example,
watershed polygons might have common edges along
ridgelines, and lake polygons might share their shoreline
edges with land cover polygons. Three watersheds might
share a single node at a mountain peak, and three river-
reach features might share a node at a confluence. You can
simultaneously edit shared edges and nodes with the
Topology Edit tool when you create a map topology.

Opening the exercise document

In this exercise you will update multiple watershed features
in two feature classes using the Topology Edit tool.
1. Start ArcMap.
2. Click the Open button on the Standard toolbar. Navigate

to the MapTopology.mxd map document located in the
Editor directory where you installed the tutorial data.
(C:\ArcGIS\ArcTutor is the default location.) Click the
map and click Open.

This map contains two feature classes. Hydro_region
contains polygon features representing three large
hydrologic regions in the southwestern United States. Note
that part of the Great Basin regional watershed has been
omitted from the tutorial dataset. Hydro_units contains
polygon features representing smaller watersheds within
these regions. You can see the features in the Hydro_units
feature class because the Hydro_region features are partly
transparent.

The regional data was derived by dissolving the smaller
hydrologic units, so the boundaries of the features in
Hydro_regions are already coincident with the boundaries
of the smaller watersheds. In this exercise, you will create a
map topology to allow you to edit the vertices that make up
a shared edge and move a node that defines the intersection
of multiple features.
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3. Click Editor and click Start Editing.
If the Topology toolbar is not on the map, you will add
it.

4. Click Editor, point to More Editing Tools, and click
Topology.

The Topology toolbar contains tools for working with
topologically related features. Some features are related by
a topology stored in a geodatabase. With an ArcInfo or
ArcEditor license, you can use the topology editing tools
on this toolbar to edit such geodatabase topologies.
You may still need to edit features that share geometry
when you are working with shapefiles or features in a
geodatabase that do not have a topology defined for them.
You can use the tools on this toolbar to create a temporary
topological relationship between coincident parts of
features�a map topology�then edit the shared parts of

features. ArcView licensed seats of ArcMap can edit map
topologies but not geodatabase topologies. ArcEditor and
ArcInfo licensed seats of ArcMap can edit both types of
topology.

Creating a map topology for an area

Before you create the map topology, you�ll zoom in to the
area that you want to edit. Zooming in to an area reduces
the number of features that the map topology analyzes
when building the topology cache.
1. Click View, point to Bookmarks, and click 3 Region

Divide.

The map zooms to the bookmarked area. Now you can
see labels for the smaller watersheds.
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2. Click the Map Topology button.

The Map Topology dialog box appears. You can select
the feature classes that will participate in the topology
and choose a cluster tolerance. The cluster tolerance
defines how close together parts of features must be
before they are considered to be coincident.

3. Click Select All.

You want all of the features on the map from both feature
classes to participate in the map topology.
The default cluster tolerance is the minimum possible
cluster tolerance and is given in coordinate system units. In
this case, the dataset is in the Universal Transverse
Mercator coordinate system, and the units are meters. You
will accept the default cluster tolerance.
4. Click OK.
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Now you will start editing the map topology using the
Topology Edit tool.
5. Click the Topology Edit tool.

6. Click the edge that is shared by the East Fork Sevier.
Utah, polygon (#16030002) and Kanab. Arizona, Utah,
polygon (#15010003).

The edge is selected and changes color.
If you have set ArcMap to show unselected topology nodes,
then open circles will also appear around the intersections
of the lines that make up the polygon edges. These are
unselected nodes in the map topology.
This edge is also shared by the larger regional polygons. To
check this you�ll use the Show Shared Features tool.

7. Click the Show Shared Features button.

The Shared Features dialog box appears.

You can use this dialog box to investigate which features
share a given topology edge or node. You can also use this
dialog box to control whether or not edits that you make to
a given topology element will be shared by certain features.
The names of both feature classes in the map topology,
Hydro_region and Hydro_units, are listed with check
marks in this dialog box. The checks mean that the selected
topology element is shared by features in these feature
classes. Next, you�ll see which features share this edge.
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8. Double-click Hydro_units.

The plus sign changes to a minus, and two more
branches expand below Hydro_units. Each of these
represents a hydrologic unit feature that shares this
edge.

9. Click East Fork Sevier. Utah. (51).
Feature number 51 in the Hydro_units feature class, the
East Fork Sevier hydrologic unit, flashes on the map.

10. Double-click Hydro_region and click Great Basin
Region (1).

Feature number 1 in the Hydro_region feature class, the
Great Basin region, flashes on the map.

11. Close the Shared Features dialog box.

Editing a shared edge in a map topology

Now that you�ve seen that the features you need to update
share this edge, you�ll update the boundary of the
watersheds to better fit the terrain.
1. Check Hillshaded_terrain.sid to turn on the image in the

ArcMap table of contents.

This is a small area of hillshaded terrain extracted from the
National Elevation Dataset Shaded Relief Image Service,
published by the U.S. Geological Survey. You can add the
original image to ArcMap from the Geography NetworkSM.
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You will use this image, and the guidelines that have been
added to it, to update your watershed data.
2. Press and hold down the Z key.

The pointer becomes the Zoom In tool.
3. While pressing the Z key, click and drag a box around

the selected edge.

The watershed data that you have is derived from the
medium resolution National Hydrography Dataset,
published by the United States Geological Survey and the
United States Environmental Protection Agency. This data
was compiled at a scale of 1:100,000. The National
Elevation Dataset hillshade is derived from 1:24,000-scale
digital elevation model data. You will use the higher
resolution hillshade data to improve the watershed
boundaries.

4. Double-click the edge to see the vertices that define the
shape of the edge.

Now you can see the vertices (in green) that define the
shape of this edge.

5. Move the pointer over the second vertex from the
eastern end of the edge. When the pointer changes to a
box with four arrows, click the vertex, drag it northwest,
then drop it on the blue guideline.
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You could continue reshaping this edge vertex by vertex,
but there is a faster way to update it.
6. Click and drag a box across part of the selected edge.

This reselects the edge and refreshes the change you
made to it.

Reshape a shared edge in a map topology

Now you�ll use an edit sketch to reshape the shared edge.
You�ll need to set the edit task to Reshape Edge and turn on
snapping to the watershed edges.
1. Click the Task drop-down list and click the Reshape

Edge topology task.

2. Click the Sketch tool on the Editor toolbar.

3. Click Editor and click Snapping.
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4. Check the box to snap to edges in the Hydro_region
feature class, then close the Snapping Environment
dialog box.

5. Move the pointer over the edge where the selected
topology edge and the blue guideline begin to diverge.

6. Click the edge to begin an edit sketch.

7. Continue adding vertices along the guide line.
8. Make sure that the last vertex you add to the sketch

snaps to the edge near the vertex you moved.

9. Press F2 or right-click and click Finish Sketch.
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The change that you made with the edit sketch is
applied to the shared edge.

Move a shared node in a map topology

Now that you�ve adjusted the edge shared by the watershed
boundaries, another problem with the existing data needs to
be fixed. The node at the east end of the edge is the point
where the Great Basin, Upper Colorado, and Lower
Colorado Region watersheds come together. You�ll move
this shared node by a specified number of meters.
1. Click the Topology Edit tool.

2. Click once on the map, off of the edge, to deselect it.
3. Press and hold down the N key.

This temporarily limits the selectable topology elements
to nodes.

4. Click and drag a box around the node while holding
down the N key.

The node is selected. Now you�ll move it to the correct
location.

5. Right-click and click Move.
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You will move this node 460 meters in the x direction
(east) and 410 m in the y direction (north).

6. Type �460� and �410� in the x and y boxes,
respectively, then press Enter.

The node is moved to the new location, and all the
features that share it in the map topology are updated.

You can also move the node by clicking and dragging it, as
you move the vertex of the topology edge.
7. Click Editor and click Stop Editing.

7

8. Click Yes if you want to save your edits.
In this exercise you learned how to create a map topology
and how to use the Topology Edit tool to edit multiple
features that share edges and nodes. The map topology
allowed you to maintain the common boundary between
the features while simultaneously editing four, then six
features in two different feature classes. The Topology Edit
tool and the topology editing tasks can also be used to edit
the edges and nodes in a geodatabase topology.

6
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Exercise 6: Importing CAD features

ArcMap lets you seamlessly integrate computer-aided
design drawings into your work. It allows you to display
and query CAD datasets without first having to convert the
drawing files to an ESRI format.
The ability to work with CAD drawings in ArcMap is
particularly useful if your organization has existing CAD
data resources that you need to use immediately in your
work.
Not only can you perform basic query and analysis
functions using ArcMap tools, you can also snap directly to
CAD features or entities when you update your database.
This exercise will show you how to import CAD features
directly into your edit session; this will allow you to easily
integrate CAD features into your work.

Opening the Exercise document

1. Start ArcMap.
2. Click the Open button on the Standard toolbar. Navigate

to the WorkingWithCAD.mxd map document located in
the Editor directory where you installed the tutorial
data. (C:\ArcGIS\ArcTutor is the default location.)

3. Zoom to the area of the map identified by the red
hatched polygon.

Using the Load Objects wizard

You can import CAD entities directly from CAD feature
classes using the Load Objects wizard. However, you�ll
need to add the Load Objects wizard into ArcMap first.
1. Click the Tools menu and click Customize. Click the

Commands tab.
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2. Click the Data Converters category from the Categories
list and drag and drop the Load Objects command onto
the Editor menu. Close the Customize dialog box.

3. Click Editor and click Start Editing. Set the Target layer
to the LotLines layer. This is the layer into which you
will load the parcel lines.

Loading CAD features

With the target layer set to the lot lines feature class, you
are ready to load features directly from the CAD drawing.
CAD drawings are represented in two ways: CAD drawing
files and CAD drawing datasets. CAD drawing datasets
contain feature classes organized by point, line, or polygon
shape types.
Each CAD feature in a CAD feature class contains a Layer
field; it lets you identify the CAD drawing layer from
which each feature is derived. In this exercise, you�ll
extract the features belonging to the lot line layer of the
polyline feature class into your empty lot line geodatabase
feature class.
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1. Click Editor and click Load Objects.
2. Click the Browse button, located to the right of the Input

data list. Navigate to where you installed the ArcTutor
sample data (C:\ArcGIS\ArcTutor by default), then
navigate to the Editor\ExerciseData\EditingCAD
directory.

3. Double-click the Parcels.dwg drawing dataset. Click the
Polyline feature class and click the Open button.

4. Click the Add button to add the CAD feature class�
listed in the Input data list�to the list of source data to
load.

5. Click Next.

Matching input and target fields

The next step in the wizard lets you match the fields of the
CAD feature class with the fields in your target layer.
1. Accept the default field mappings for this exercise.

Click Next.

Defining a query

Since all CAD layers are combined into a single feature
class containing a Layer attribute value, you will define an
attribute query so that only features with a layer name =
�LOT-L� will be loaded into the target layer.
1. Click the option to load only features that satisfy the

query.
2. Click Query Builder to define the query.
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3. Double-click Layer in the Fields list. This adds the
string to the where clause for the query.

4. Click the equal (=) sign.

5. Click Get Unique Values to display all unique attribute
values for the Layer field. Double-click LOT-L from the
list to complete the query.
After completing the steps above, your query should
read: "Layer" = 'LOT-L'. You can alter the query by
typing directly into the where clause box.

6. Click Verify to ensure that you have created a valid SQL
where clause.

7. Click OK. Make sure that you have a valid query
expression before applying the query to the wizard.

8. Click Next on the Object Loader dialog box.

Snapping and validation

Next, the Object Loader will ask if you want to apply any
snapping agents that you have set in the Snapping
Environment dialog box to features as they are loaded into
the map and whether you want to validate each feature that
is added.
If you�re concerned about the connectivity between
features that you import and existing features in your
database, you may want to apply snapping. However, you
should be aware that features will move within the current
snapping tolerance. If the source CAD data was
constructed using coordinate geometry, applying snapping
may reduce the accuracy of the original data.
1. Click Next (do not apply snapping).
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Saving your edits

Now that you have successfully loaded CAD data into your
edit session, you can stop editing and save your edits.
1. Click Editor and click Stop Editing.

2. Click Yes to save your edits. You�ll use this data in the
next exercise.

In this exercise, you learned how to load CAD features
directly into your GIS database. You were able to import
features by their shape type and by their CAD layer name
using the Load Objects wizard. But you don�t have to
import CAD data to use it. You can also snap directly to
CAD features or simply display and query their attributes.

Completing the wizard and loading features

The final dialog box provides a summary of the options
that you chose through each step of the wizard. You can
examine each of your steps and click Back if you made any
mistakes.
1. Click Finish.

A progress indicator will appear.

Once the wizard has finished loading features, you may
need to refresh the display to see the new lot lines.
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Exercise 7: Using geodatabase topology to clean up your data

The CAD lot lines data that you loaded in the previous
exercise needs some quality checking, editing, and other
processing for you to have useful parcel polygon features
for your geodatabase.
You will create a simple geodatabase topology rule to help
you find digitizing errors in the lot line data, then use the
topology and editing tools to fix these errors. Once the
problems, mostly lines that do not close to form polygons,
are fixed, you will create a new polygon feature class from
the lot lines. You�ll add the polygons to the topology, then
use the topology to identify and resolve other errors in the
data.
If you have not loaded the lot lines, a duplicate of this
feature dataset with the lot lines already loaded may be
found where the tutorial data is installed at:
C:\ArcGIS\ArcTutor\Editor\ExerciseData\
TopologyEdits\TopologyTutorial.gdb.
You must close ArcMap before building the topology to
release the lock on the database.
1. Close ArcMap. You do not need to save changes to the

map.

Navigating to the study area dataset

1. Start ArcCatalog.
2. Click the Connect to Folder button.

3. Navigate to the ExerciseData folder. The default
location for this folder is C:\ArcGIS\ArcTutor\Editor.

4. Click OK.
5. Double-click the folder connection.
6. Double-click the EditorTutorial geodatabase.

7. Click StudyArea.
This is the feature dataset into which you loaded the
CAD lot lines in the previous exercise.
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Creating a geodatabase topology

Now you�ll create a geodatabase topology to help you find
errors in the LotLines data. The topology will be simple,
involving one feature class and one topology rule.
1. Right-click the StudyArea dataset, point to New, and

click Topology.

2. Click Next.

On the next panel of the wizard, you can set the cluster
tolerance. The cluster tolerance is the minimum distance
that separate parts of features can be from each other.
Vertices and edges of features that fall within the cluster
tolerance are snapped together.
By default, the wizard gives the smallest possible cluster
tolerance, which is determined by the precision of the
spatial reference of the dataset. The precision of a dataset
defines how many system units can be stored per unit of
linear measure and controls how precisely coordinates are
stored in the dataset.
3. Click Next.
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Now you can choose which feature classes in the dataset to
include in the topology.
4. Check LotLines.

5. Click Next.
When you have more than one feature class in a topology,
you can give them different ranks. When vertices or edges
of features fall within the cluster tolerance of each other,
the feature class ranks control which is moved to the
other�s location. Feature classes of a lower rank will be
snapped to feature classes of a higher rank. The highest
rank is 1; the lowest is 50. Parts of features of the same
rank that fall within the cluster tolerance are geometrically
averaged.

6. Click Next.

When you build a topology, you can pick the rules that will
govern the allowable spatial relationships between
features.
7. Click Add Rule.
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8. Click the Rule drop-down list and click Must Not Have
Dangles.

Dangles are the endpoints of lines that are not snapped to
other lines in the feature class. You will want to find the
dangles in the LotLines feature class because they
represent places where the imported CAD line work will
not produce closed polygons.
9. Click OK.

The rule is added to the list of topology rules.
10. Click Next.

11. Click Finish.

You get a message that the topology is being built, then
another asking whether you want to validate the
topology now.

12. Click Yes.

You get a message that the topology is being validated,
and the new topology appears in the StudyArea dataset.
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Adding the topology to the map

Now you�ll use the topology to help you find the dangle
errors in the LotLines data. It is important to clean up this
data before you create polygon features because only one
lot polygon will be created if a line dividing two lots does
not completely separate them.
1. Click the Launch ArcMap button to start a new map.

2. If the Startup dialog box appears, click the button to
start a new empty map.

4. Resize the ArcMap and ArcCatalog windows so that you
can see both.

5. Click StudyArea_Topology and drag it onto the map.

6. Click Yes when you are asked whether to add all the
layers that participate in the topology.

3. Click OK.
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The topology layer and the LotLines features are added
to the map.

The Topology layer shows all of the topology errors.
Notice that in the ArcMap table of contents, the topology
layer can show Area, Line, and Point errors. This topology
only has one feature class and one rule, so all of the
topology errors relate to that rule. The topology rule
specifies that LotLines must not have dangles. The error
geometry for dangles is a point, located at the dangling end
of a line feature. All of the red error features on the map
are dangles.

Finding topology errors

The next step to make this data useful is to identify the
topology errors that are present. Lot lines that have a
dangle, where one end of the line is not connected to
another lot line, are errors that you need to find to clean up
this data so you can create lot polygons. Some dangles
need to be extended to close a polygon; others overshoot
the line that they should snap to and need to be trimmed.
You will find some of these errors now.
1. Click Editor and click Start Editing.

2. Click the Zoom In tool.
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3. Click and drag a box around the three red error features
located near the middle of the map, to the right of and
above the north�south and east�west trending series of
errors.

Now you can see three of the errors.

You will use tools on the Topology toolbar to find out more
about these errors and to correct them. If the Topology
toolbar is visible, skip the next step in which you add the
toolbar.
4. Click Editor, point to More Editing Tools, and click

Topology.

5. Click the Error Inspector button on the Topology
toolbar.
The Error Inspector allows you to manage and interact
with all of the topology errors on your map.
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6. Check the Errors and Visible Extent only check boxes.

7. Click Search Now.

You may see additional errors if the map display changed
shape when you added the Error Inspector.

Correcting an overshoot error

All the errors on the map are violations of the Must Not
Have Dangles rule. However, there are several different
problems that can cause this type of error. A dangle error
can be caused by a line that extends too far beyond the line
it is supposed to touch or by a line that doesn�t extend quite
far enough. These are called overshoots and undershoots,
respectively.

Dangles can also occur where features have been digitized
from adjacent map sheets. These lines sometimes need to
be snapped together so they connect to form a continuous
line. Other dangle errors occur at the edge of map sheets,
where a line is cut off on the original source data.
You will now correct one of the errors on this map.
1. Click in the Feature 1 column until the northernmost

feature on the map flashes and turns black to show that
it�s selected. (You may see different Feature 1 values.)

2. Click and drag a small box around the error to zoom to
the error.
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3. Zoom in again, if necessary, until you can see where the
lot line with the error crosses the other lot line.

This is an overshoot error, a type of error that is often
found in line work imported from CAD programs or
digitized without using snapping to control the
connectivity of the line features.

4. Right-click the error in the Error Inspector and click
Trim.

5. Type �3� in the Maximum Distance box and press Enter.

The dangling segment is trimmed back to where the
lines intersect, and the error disappears.

The Error Inspector context menu provided a list of
potential fixes for this error. You trimmed the line feature
to fix this error. You also could have marked the error as an
exception or snapped or extended the line until it reached
another feature.

Correcting an undershoot error

Now you�ll correct another type of dangle error.
1. Click the Go Back to Previous Extent button until you

can see the two remaining errors in this area of the data.
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2. Click the Zoom In tool and drag a box to zoom in to the
westernmost of the two remaining errors.

3. Zoom in again, if necessary, until you can see where the
lot line with the error fails to connect to the other lot
line.

This is an undershoot error, another type of error that is
often found in line work imported from CAD programs or

digitized without using snapping to control the connectivity
of the line features. The end of this line fell short by a little
more than half a meter. You�ll fix this error by extending
the undershoot until it meets the line to which it should
have been snapped.
4. Click the Fix Topology Error tool.

The Fix Topology Error tool lets you interactively select
and apply predefined fixes to topology errors on the map.
5. Click and drag a box around the error.
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6. Right-click the map and click Extend.

7. Type �3� in the Maximum Distance box and press Enter.

You�ve corrected the undershoot by extending the line
with the dangle to the other line.

If the distance to the next line had been greater than the
three-meter maximum distance you specified, the line
would not have been extended.

Correcting a double-digitized line

Sometimes a given line or part of a line is digitized twice in
the course of creating the data. This may happen with CAD
drawings or with lines digitized on a digitizing tablet.
1. Click the Go Back to Previous Extent button until you

can see the one remaining error in this area of the data.

2. Click the Zoom In tool and drag a box to zoom in to the
remaining error.
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3. In the Error Inspector, click Search Now.

4. Click the numeric value in the Feature 1 column.

The line feature with the dangle flashes. Notice that the
whole lot line did not flash.

5. Click and drag a box to zoom closer to the dangle error.

If necessary, zoom in again until you can see that there
are two nearly parallel lot lines, one of which has the
dangle.
You�ll correct this error by deleting the extra line.
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6. Right-click the numeric value in the Feature 1 column
and click Select Features, then press the Delete key.

The extra line is deleted.
7. Click the Go Back to Previous Extent button until you

can see the area in which you�ve been working.

You�ve fixed three errors that resulted from violations of
the Must Not Have Dangles rule. In each case, the error
was corrected by editing the geometry of a lot line feature
by trimming, extending, or deleting the feature.
Topology errors are useful for tracking where there are
problems with your data, but correcting the error requires
you to correct the data�you can�t edit the Topology error
feature layer directly.

Reviewing the areas you’ve edited

When you edit features in a topology, the topology tracks
where changes have been made. These places are called
dirty areas because a topology rule could potentially have
been violated by the edits, but the error, if it exists, cannot
be found until the dirty area is validated again. When you
validate the topology again, it just checks the dirty areas.
You can see the areas that have been edited by showing the
dirty areas in the topology layer.
1. Click StudyArea_Topology in the ArcMap table of

contents so only it is selected. Right-click it and click
Properties.
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2. Click the Symbology tab.
3. Check Dirty Areas.
4. Click OK.

Now you can see the dirty areas on the map. The dirty
areas cover the features that you edited. Dirty areas
optimize the validation process, as only these must be
checked for errors.

5. Click the Validate Topology in Specified Area tool.

6. Click and drag a box around the northern dirty area.

The dirty area is removed, and no errors are found in the
area you validated.
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7. Click the Validate Topology in Current Extent button.

The topology is validated for the other areas you edited,
and the dirty area is removed.

Creating a report of the status of the data

Next you�ll generate a report summarizing the number of
topology errors remaining in the data.

1. Right-click the topology in the ArcMap table of contents
and click Properties.

2. Click the Errors tab.
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3. Click Generate Summary.
The summary shows the number of topology errors and
exceptions; you may have a different number of errors.
You can save this report to a text file to document the
status of the data, but you do not need to for this
exercise.

4. Click OK.

Fixing multiple errors at once

Many errors, like the double-digitized line, need to be fixed
one at a time by deleting, modifying, or moving individual
features. Some errors must be fixed by creating new
features. However, sometimes a feature class contains a
number of errors, such as the overshoots and undershoots,
that are simple to fix. When this is the case, you can select
multiple errors at once with the Fix Topology Error tool

and apply the same fix to all of them. If you prefer, you can
individually check each error using the Error Inspector.
This is a workflow and quality assurance decision that your
organization should make before you begin applying
topology fixes to multiple errors.
Before applying a fix to multiple errors, it�s a good idea to
look at your data and evaluate whether the fixes are
appropriate. You would not want to trim lines with dangles
that actually needed to be snapped to another line, or
extend a line that actually needed to be trimmed.
In this case, if you extend dangling lines that are within
three meters of another line, you�re not likely to cause
problems with your data, since the parcels and rights-of-
way are larger than three meters.
Now you�ll use this method to clean up several errors at
one time.
1. Click the Full Extent button.

2. Click the Fix Topology Error tool.
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3. Click and drag a box around all the errors on the map.

This selects all of the errors. Now you�ll fix the
undershoots.

4. Right-click the map and click Extend.
5. The Maximum Distance you set when you fixed the

other undershoot is fine, so press Enter.

The process may take a few seconds while all of the
features with dangles are checked to see if there is a
feature within three meters to which they can be
extended.
The undershoots are fixed, and a number of dirty areas
appear on the map. Each dirty area marks the bounding
box of a feature that was edited by the extend error fix.

6. Click Search Now on the Error Inspector. (If you closed
the Error Inspector dialog box, you can open it again
from the Topology toolbar.)
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Creating a new polygon feature class

Now you�ll create a new feature class of lot polygons from
the lot lines feature class that you�ve been working on and
from a point feature class that will supply the attributes of
the new lot features.
1. Right-click the StudyArea dataset in ArcCatalog, point

to New and click Polygon Feature Class From Lines.

7

8

The number of errors
still remaining

1

The number of topology errors is displayed to the right
of the Show drop-down menu; you may have a different
number of errors remaining. You will notice that many
have been fixed. You could continue fixing topology
errors to clean up this data, but you�ll skip ahead in the
process now to see some other ways to clean up data
with topology.

7. Click the Editor menu and click Stop Editing.

8. Click Yes to save your edits.

9. Close ArcMap.
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2. Type �Lots� as the new feature class�s name.

3. Check LotLines.
4. Click the point feature class drop-down list and click

LotIds.
5. Click OK.

The new Lots polygon feature class is added to the
StudyArea dataset. Next, you will include the Lots and
LotIds feature classes in the topology so you can add
rules to help you continue to clean up the data.

Adding feature classes to the topology

Before you can add topology rules for feature classes, you
need to add the feature classes to the topology.
It is important to note that you are using this topology for
the purpose of improving the polygon feature class you
created from line work and points. You do not need to have
the line or point feature classes to model the Lots�some
organizations might decide to keep the LotLine feature
class to provide easy annotation of lot boundary lengths,
while others might not. Likewise, the Lots Parcel_ID
attribute is now stored in the polygon feature class�you�re
using the LotIds feature class to quality check the data
you�ve created. You might decide not to keep the LotIds
feature class when you�ve finished checking the data.
1. Right-click StudyArea_Topology and click Properties.
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2. Click the Feature Classes tab.

3. Click Add Class.
4. Click LotIds, press and hold down the Ctrl key, and

click Lots.

5. Click OK.

Now that you�ve added these two feature classes to the
topology, you can include them in topology rules.

Adding rules to the topology

1. Click the Rules tab.

2. Click Add Rule.
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3. Click the Features of feature class drop-down arrow and
click LotIds.

4. Click the Rule drop-down arrow and click Must be
Properly Inside.

5. Click the Feature class drop-down arrow and click Lots.
6. Click OK.
This rule will be useful for finding places where lot
polygons were not formed due to breaks in the line work.
7. Click Add Rule.

8. Click the Features of feature class drop-down arrow and
click LotLines.

9. Click the Rule drop-down arrow and click Must be
Covered By Boundary Of.

10. Click the Feature class drop-down arrow and click Lots.
11. Click OK.
This rule will be useful for finding polygons that were not
completely split due to gaps in the line work.
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Adding the new topology to ArcMap

Now you�ll examine the revised topology in ArcMap and
continue cleaning up your data.
1. Start ArcMap.
2. Click and drag the topology from ArcCatalog onto

ArcMap.

3. Click Yes to add all the feature classes that participate in
the topology to the map.

The topology and the feature classes that participate in it
are added to the map.
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12. Click OK.

13. Right-click StudyArea_Topology and click Validate.

You�ve added two more feature classes to the topology and
added topology rules to control their spatial relationships.
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4. Click the Zoom In tool.

5. Click and drag a box around the central part of the south
edge of the data.

Now there are line and point errors visible on the map.

The red lines represent a new type of error feature�line
errors. These show violations of the Must Be Covered

By Boundary Of rule. There are two types of point
errors now, violations of the Must Not Have Dangles
rule, which you�re already familiar with, and violations
of the Must Be Properly Inside rule.

Changing a point error symbol

Since there is now more than one type of point error, you
will change the symbology of the Topology layer to make it
clearer which errors are which.
1. Click StudyArea_Topology in the ArcMap table of

contents so only it is selected. Right-click it and click
Properties.
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2. Click the Symbology tab.
3. Click Point Errors.
4. Click the square symbol for Must Be Properly Inside

errors.

5. Click a triangle symbol and set the color to red.

6. Click OK.
7. Right-click each of the square symbols for the other two

errors and set their colors to Medium Coral Light.

8. Click OK.
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The triangle marks the LotID point for a lot that was not
created when you created polygons from lines. The red
square to the east of the triangle is actually a pair of
dangles where the lot lines were not snapped together.
The two lot lines are marked as errors because they are
not covered by a lot polygon boundary.

1. Click Editor and click Start Editing.

2. Click the Error Inspector button.

3. Click Search Now.

The visible extent of your map will determine how
many errors you see.

4. Click the Show drop-down list and click LotIds - Must
Be Properly Inside - Lots.

5. Click Search Now.

Now you can see the one violation of this rule visible in
this part of the data. You can use the Error Inspector to
sort through the various types of topology errors in your
map.

6. Uncheck Visible Extent only.
7. Click Search Now.
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There are several violations of this rule in the topology.
After you fix this error, you could use the Error
Inspector to systematically find the other LotIDs that
are not within Lot polygons, although for this exercise
you will not.

8. Right-click a feature in the Error Inspector table and
click Pan To.
The map pans to the error you selected.

Now you�ll go back to the error you were just looking at
and fix it.

9. Click the Go Back to Previous Extent button.

8 9
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Creating a new polygon

Now you will create the new lot and fix these topology
errors.
1. Click the Target drop-down arrow on the Editor toolbar

and click Lots.

2. Press Alt+R and press N.
The key combination Alt+R opens the Editor menu, and
N opens the Snapping Environment dialog box.

3. Check the End box for LotLines and close the dialog
box.

4. Click the Edit tool.

5. Hold down the Z key and drag a box around the place
where the lot lines should intersect.

6. Double-click the northern lot line, move the pointer over
its eastern end until the pointer changes to a box with
four arrows, click the end, and drag it east until it snaps
to the other lot line.

7. Click the Go Back to Previous Extent button.
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You should be able to see the lot lines and the lot
polygons that adjoin this lot to the south and west. Now
the new polygon can be constructed.

8. Hold down the Shift key and click the eastern lot line.

Both northern and eastern lot lines should now be
selected.

9. Click the Construct Features tool.

10. Click the option to create new polygons considering
existing features.

11. Click OK.
The new Lot polygon feature is created from the
selected lines and from the existing Lot polygon
boundaries.

12. Click the Validate Topology in Current Extent button.

The new polygon covers the LotID point, the polygon
boundary covers the lot lines, and you fixed the dangle
errors by snapping them together, so when you
validated the topology in the area, all of those errors
went away.
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It is important to note that the new polygon has a <null>
value for its Parcel_ID attribute. The other parcels, which
you created in ArcCatalog, derived their Parcel_ID
attribute values from the LotID point feature class. There
are several ways that you could add this information to the
new parcel. You could edit the parcel�s attributes and type
in its Lot_ID value. You could select the LotID point
feature and the Lot polygon, open the Attributes dialog
box, and copy and paste the Parcel_ID value from one to
the other. You could even use the Attribute Transfer tool on
the Spatial Adjustment toolbar to transfer the attributes
from the point to the polygon.
For this exercise you�ll skip updating the new polygon
feature�s attributes and move on to edit another Lot
polygon.

Splitting a polygon

Because there were some undershoot dangle errors with
gaps larger than three meters, there are some lots that were
not completely enclosed. Where the gap opened onto an
adjacent lot, and the two lots� other boundaries were
closed, a single large lot was created. In this step you�ll
split up one such lot.
1. Click the Full Extent button.

2. Hold down the Z key and drag a box around the lots on
the south side of the eastern part of the study area.

3. Click one of the lots that are on either side of the Must
Be Covered By Boundary Of line error.

The lots are incorrectly represented by a single feature.
The error at the south end of the line error is an
undershoot dangle error. You�ll use a new method to fix
this error using a tool on the Advanced Editing toolbar.

2

1

3



EDITING GIS FEATURES TUTORIAL 75

4. Click Editor, point to More Editing Tools, and click
Advanced Editing.
The Advanced Editing toolbar appears.

5. Click the Extend tool.

The Extend tool works differently from the Extend
topology error fix. Rather than specifying a distance, you
select a feature to which the tool will extend a line. After a
feature is selected, you click the line feature that you want
to extend. Since the parcel is currently selected, all you
have to do is click the dangling lot line. You�ll zoom in a
little closer to see the gap.

6. Press and hold down the Z key and drag a box around
the line near the south edge of the parcel.

7. Move the pointer over the dangling end of the line.

When the pointer gets close to the endpoint, the blue circle
snaps to it. Although you can click anywhere on the line
that you want to extend, the Extend tool obeys the current
snapping environment. Since you set up snapping to
endpoints of LotLines earlier, the Extend tool snaps to
them.
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8. Click the line.

The line is extended to the nearest selected feature�in
this case, the edge of the Lot polygon.

9. Click the Go Back to Previous Extent button.

10. Click the Edit tool, then click an empty space
somewhere on the map to deselect all features.

11. Uncheck all layers but LotLines on the Selection tab of
the table of contents. This will make it easier to select
only the line feature. Click the line that you just
extended, and make sure it is the only feature that is
selected.

12. Click the Construct Features tool.

13. Click the option to split existing features in the target
layer using selection.

14. Click OK.
The newly extended line feature splits the existing
parcel into two features.
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15. Click the Validate Topology in Current Extent button.

The topology is validated and the line error and dangle
are removed.

You will need to check the attributes of both of these lots
against the attributes of the LotIds points and update one or
both of them to make sure they have the right PARCEL_ID
numbers. The new lot feature has a <null> PARCEL_ID,
and there is a 50 percent chance that the wrong parcel
inherited the value from the original large parcel.
There are many more errors in the data, although as you
saw in this and the previous examples, more than one error
may be related to a given problem. Almost all of the errors
follow from the underlying problem of the original CAD
data, incompletely snapped line work and unclosed
polygons. Spending more time editing the dangle errors
would have taken care of most of the errors that were
revealed by adding the new rules.

Some of the errors, like the small dangling line and the lot
line not covered by a parcel boundary visible here, may not
need to be corrected at all. If your organization needs only
to model lots, the LotLine and LotIDs feature classes could
be removed from the topology and deleted once you�ve
finished developing the polygon features from them. On the
other hand, you might want to keep the lot lines for
cartographic reasons or to simplify annotating the
dimensions of lots. If this is the case, you would need to
continue cleaning up the lot lines. An additional step would
be to use the Planarize Lines tool to split all of the lot lines
at intersections�something that was not done with the
original CAD data. The two errors visible above are
actually on the same feature. Planarizing the lines would
split this feature into several features, each tracing a single
lot boundary.
Whether or not you retain the LotLines and LotIds feature
classes, you would probably want to add at least one more
rule to assist in the day-to-day management of the lot
feature class. One such rule would be a Must Not Overlap
rule, so when you digitize new lots they cannot overlap
each other. This should not be a problem for the lots you�ve
just created, but it is a rule that one would typically enforce
on landownership polygons.
In this exercise, you created a geodatabase topology with
simple rules to help you clean up data. You learned how to
use the Error Inspector to find errors of a particular type
and how to use some of the many editing tools to fix errors
in your data.
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Exercise 8: Using the Spatial Adjustment tool

The Spatial Adjustment tool allows you to transform,
rubbersheet, and edgematch your data within an edit
session.
Spatial adjustments are based on displacement links. These
are special graphical elements that represent the source and
destination locations for an adjustment.
This exercise will show you how to perform each of the
spatial adjustments.

Starting ArcMap and beginning editing

Before you can complete the tasks in this tutorial, you must
start ArcMap and load the tutorial data.
1. Double-click a shortcut installed on your desktop or use

the Programs list in your Start menu to start ArcMap.
2. Click the Open button on the Standard toolbar. Navigate

to the Transform.mxd map document in the Editor
directory where you installed the tutorial data.
(C:\ArcGIS\ArcTutor is the default location.)

2

3. If the Editor toolbar isn�t displayed in ArcMap, click the
Editor Toolbar button on the Standard toolbar to add it.

4. Click Editor and click Start Editing.
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Adding the Spatial Adjustment toolbar

1. Click the View menu, point to Toolbars, and click
Spatial Adjustment to add the Spatial Adjustment
toolbar to ArcMap.

2

The Spatial Adjustment toolbar appears.

Setting the snapping environment

Before you start adding links, you should set your snapping
environment so each link you add snaps to the vertices or
endpoints of features.

1. Click the Editor menu and click Snapping to display the
Snapping Environment dialog box.

2. Check the Vertex check box next to the NewParcels and
SimpleParcels layers to snap the displacement links to
the vertices of these features. Close the dialog box.
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Applying a transformation

A transformation is used to convert the coordinates of a
layer from one location to another. This involves the
scaling, shifting, and rotation of features based on
displacement links defined by the user. Transformations are
applied uniformly to all features in a feature class and are
often used to convert data created in digitizer units into
real-world units represented on a map.
This exercise will show you how to apply a transformation
based on displacement links that you will create. This
transformation will move, scale, and rotate two feature
classes containing parcel and building features into
alignment with another set of parcel and building feature
classes. You might use this technique to adjust data that
was digitized or imported into a temporary feature class in
preparation for copying and pasting the features into your
database. You will also learn how to specify which features
to adjust, preview the adjustment, and view a link table.

Specifying the features to adjust

The Spatial Adjustment tool allows you to adjust a selected
set of features or all the features in a layer. This setting is
available in the Choose Input For Adjustment dialog box.
The default is to adjust a selected set of features.

1. Click the Spatial Adjustment menu and click Set Adjust
Data to display the Choose Input For Adjustment
window.

2. Click All features in these layers.

3. Uncheck the SimpleBuildings and SimpleParcels layers,
keep the NewBuildings and NewParcels layers checked,
and click OK.
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Selecting an adjustment method

Now that you have determined which features will be
adjusted, the next step is to choose an adjustment method.
The Spatial Adjustment tool supports several adjustment
methods. In this exercise, you will perform a Similarity
Transformation.
1. Click the Spatial Adjustment menu, point to Adjustment

Methods, and click Transformation - Similarity to set
the adjustment method.

Adding displacement links

Displacement links define the source and destination
coordinates for an adjustment. Displacement links can be
created manually or loaded from a link file. In this
exercise, you will create your own displacement links from
the exterior corners of the NewParcels layer to the
corresponding locations in the SimpleParcels layer.

2

1

1. Click the New Displacement Link tool on the Spatial
Adjustment toolbar.

2. With the New Displacement tool active, snap to a from-
point in the source layer and snap to a to-point in the
target layer.

1
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Examining the adjustment

The Spatial Adjustment tool includes a tool to preview an
adjustment prior to actually performing the adjustment.
This tool is called the Preview Window. If the results of the
adjustment are not adequate, you can modify the links to
improve the accuracy of the adjustment.
1. Click the Spatial Adjustment menu and click Preview

Window.

The Adjustment Preview Window appears.

3. Continue to create additional links as shown below. For
this exercise, you should have a total of four
displacement links when you are finished.

1
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2

In addition to the visual preview of the adjustment, you can
also examine the results of the adjustment by viewing the
Link Table. The Link Table provides information about link
coordinates, link IDs, and RMS errors.
2. Click the View Link Table button on the Spatial

Adjustment toolbar.

The Link Table dialog box appears.
Right-clicking a link record opens the Link Table�s context
menu. You can edit link coordinates, flash links, zoom and
pan to selected links, and delete links with these
commands.

If the RMS error for this adjustment is not acceptable, you
can modify the links to increase the accuracy. The Preview
Window and Link Table tools are designed to help you
fine-tune your adjustment.

Performing the adjustment

The final step of the spatial adjustment process is to
perform the adjustment.
1. Click the Spatial Adjustment menu and click Adjust.

Since the Spatial Adjustment tool operates in an edit
session, you can use the Undo command to undo the
adjustment.
The adjusted data should look like this:

1
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Saving your edits

If you are satisfied with the results of the spatial
adjustment, you can stop editing and save your edits.
1. Click Editor and click Stop Editing.

2. Click Yes to save your edits.

In this exercise, you learned how to set your data for an
adjustment, create displacement links, preview the
adjustment, and use the Link table to view the RMS error.

1

Rubbersheeting your data

Rubbersheeting is typically used to align two or more
layers. This process moves the features of a layer using a
piecewise transformation that preserves straight lines.
This exercise will show you how to rubbersheet data by
using displacement links, multiple displacement links, and
identity links. You will rubbersheet a newly imported set of
street features to match an existing feature class of street
features.
This tutorial assumes that ArcMap is started and the Editor
and Spatial Adjustment toolbars have been added to
ArcMap.
1. Close the Transform.mxd map document.
2. Click the Open button on the Standard toolbar. Navigate

to the Rubbersheet.mxd map document in the Editor
directory where you installed the tutorial data.
(C:\ArcGIS\ArcTutor is the default location.)

2
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3. Click Editor and click Start Editing.

3

Setting the snapping environment

Before you start creating links, you should set your
snapping environment so each link you add snaps to the
vertices or endpoints of features.
1. Click the Editor menu and click Snapping to display the

Snapping Environment dialog box.

1
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2. Check the Vertex check box next to the ImportStreets
and Streets layers to snap the displacement links to the
vertices of these features. Close the dialog box.

Setting data for the adjustment

The Spatial Adjustment tool allows you to adjust a selected
set of features or all the features in a layer. This setting is
available in the Choose Input For Adjustment dialog box.
The default is to adjust selected features.
1. Click the Spatial Adjustment menu and click Set Adjust

Data to display the Choose Input For Adjustment dialog
box.

2. Click All features in these layers.

3. Uncheck the Streets layer. Keep the ImportStreets layer
checked, then click OK.
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Selecting an adjustment method

Now that you have determined which features will be
adjusted, the next step is to choose an adjustment method.
The Spatial Adjustment tool supports several adjustment
methods. In this exercise, you will use Rubbersheet.
1. Click the Spatial Adjustment menu, point to Adjustment

Methods, then click Rubbersheet to set the adjustment
method.

2. Click the Spatial Adjustment menu and click Options to
open the Adjustment Properties dialog box.

3. Click the General tab, then click Rubbersheet from the
Adjustment method drop-down list.

4. Click Options to choose a rubbersheet
method.

5. Click the Natural Neighbor method and click OK.

6. Click OK to close the Adjustment Properties dialog box.
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Locating the adjust data

Spatial bookmarks are named extents that can be saved in
map documents. Creating a bookmark for areas that you
visit frequently will save you time.
You will now zoom to a spatial bookmark created for this
exercise.
1. Click the View menu, point to Bookmarks, then click

Import streets to set the current view to the edit area of
this exercise.

When the display refreshes, note that the ImportStreets
layer is not aligned with the Streets layer. You must adjust
the ImportStreets layer so it aligns with the Streets layer by
using the rubbersheet adjustment method.

1
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2. To get a better view of the adjustment area, you need to
zoom to the bookmark called Intersections, which was
created for you. Click the View menu, point to
Bookmarks, then click Intersections.

Adding displacement links

Displacement links define the source and destination
coordinates for an adjustment. Displacement links can be
created manually or loaded from a link file. In this
exercise, you will create your own displacement links at
several key intersections of the Streets and ImportStreets
layers.
1. Click the New Displacement Link tool on the Spatial

Adjustment toolbar.

2. Snap the link to the source location in the ImportStreets
layer, as shown below.

12
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3. Snap the link to the destination location in the Streets
layer, as shown below.

4. Continue to create links at the perimeter intersections of
the layers in a counterclockwise direction. You will
create a total of six displacement links, as shown below.

Adding multidisplacement links

The Multiple Displacement Links tool allows you to create
multiple displacement links in one operation. This tool can
help save time by allowing you to create more than one link
at a time; it is especially useful for curved features.
1. To get a better view of the adjustment area, zoom to the

bookmark called Curve features, which was created for
you. Click the View menu, point to Bookmarks, and
click Curve features.

To preserve the curved road features, add multiple links at
critical points.

3

1
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2

2. Click the Multiple Displacement Links tool on the
Spatial Adjustment toolbar.

3. With the Multiple Displacement Links tool active, click
the curved road feature in the ImportStreets layer.

3

4. With the Multiple Displacement Links tool still active,
click the curved road feature in the Streets layer.

5. You will be prompted to enter the number of links to
create. Accept the default value (10) and press Enter.

5

4
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6

8

7

7. Click the New Displacement Link tool on the Spatial
Adjustment toolbar.

8. Add the final displacement links, as shown below:

The multiple links now appear in the map.

6. Use the Multiple Displacement Links tool to create
multiple links for the remaining curved feature.
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Adding identity links

Identity links are used to anchor features at specific points
to prevent their movement during an adjustment. You will
now add identity links at key intersections to maintain their
locations.
1. Click the New Identity Link tool on the Spatial

Adjustment toolbar.

2. With the New Identity Link tool active, add five identity
links at the intersections shown below.

Examining the adjustment

You can examine how an adjustment will appear prior to
actually performing it with the Preview Window. Use the
standard ArcMap Zoom and Pan tools to change the display
of the Preview Window.
1. Click the Spatial Adjustment menu and click Preview

Window to examine the adjustment.

The Adjustment Preview Window appears.

If the results are not acceptable, modify the existing links
to improve the accuracy of the adjustment.

2

1

1
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Performing the adjustment

The final step of the spatial adjustment process is to
perform the adjustment.
1. Click the Spatial Adjustment menu and click Adjust.

Since the Spatial Adjustment tool operates in an edit
session, you can use the Undo command to undo the
adjustment. Here is how the adjustment should appear:

After performing the rubbersheet adjustment, you will
notice that all of the displacement links you created have
turned into Identity links. The next step is to delete these
links since you no longer need them.
1. Click the Select Elements tool on the Spatial

Adjustment toolbar. This will allow you to select the
links since they are graphic elements.

2. Click the Edit menu and click Select All Elements.

3. Press the Delete key.

2

1

1
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Saving your edits

If you are satisfied with the results of the spatial
adjustment, you can stop editing and save your edits.
1. Click the Editor menu and click Stop Editing.

2. Click Yes to save your edits.

In this exercise, you learned how to set your data for an
adjustment, create displacement links, create identity links,
and preview the adjustment.

1
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Edgematching data

Edgematching is used to align features along the edges of
adjacent layers. Usually, the layer with the less accurate
features is adjusted, while the other layer is used as the
target layer. Edgematching relies on displacement links to
define the adjustment.
In this exercise, you will edgematch two adjacent tiles of
stream data by using displacement links that you will
create. You will also learn how to use the Edge Match tool
and set Edge Snap properties.
This tutorial assumes that ArcMap is started and the Editor
and Spatial Adjustment toolbars have been added to
ArcMap.
1. Close the Rubbersheet.mxd map document.
2. Click the Open button on the Standard toolbar. Navigate

to the EdgeMatch.mxd map document in the Editor
directory where you installed the tutorial data.
(C:\ArcGIS\ArcTutor is the default location.)

3. Click Editor and click Start Editing.

3

2
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Setting the snapping environment

Before you start creating links, you should set your
snapping environment so each link you add snaps to the
vertices or endpoints of features.
1. Click the Editor menu and click Snapping to display the

Snapping Environment dialog box.

2. Check the End check boxes next to the StreamsNorth
and StreamsSouth layers to snap the displacement links
to the endpoints of these features. Close the dialog box.

1

2
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Setting data for the adjustment

The Spatial Adjustment tool allows you to adjust a selected
set of features or all the features in a layer. This setting is
available in the Choose Input For Adjustment dialog box.
The default is to adjust a selected set of features.
1. Click the Spatial Adjustment menu and click Set Adjust

Data to display the Choose Input For Adjustment dialog
box.

2. Click Selected features and click OK.

Choosing an adjustment method

Now that you have determined which features will be
adjusted, the next step is to choose an adjustment method.
The Spatial Adjustment tool supports several adjustment
methods. In this exercise, you will use Edge Snap.
1. Click the Spatial Adjustment menu, point to Adjustment

Methods, then click Edge Snap to set the adjustment
method.

2. Click the Spatial Adjustment menu and click Options to
open the Adjustment Properties dialog box.
You will define several edgematch settings and
properties in this dialog box.2

1

1
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Setting the adjustment method properties

1. Click the General tab, then click the Adjustment method
drop-down arrow and click Edge Snap as your
adjustment method.

2. Click Options to open the Edge Snap dialog box.

3. Click Line as the method and click OK.

The line method only moves the endpoint of the line being
adjusted. The Smooth method distributes the adjustment
across the entire feature.

Setting the edgematch properties

The edgematch adjustment method requires additional
adjustment methods. These properties will define the
source and target layers as well as determine how the
displacement links will be created when using the Edge
Match tool.
1. Click the Edge Match tab of the Adjustment Properties

dialog box.
2. Click the Source Layer drop-down arrow and click

StreamsNorth.

1 2
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Locating the adjust data

You will now zoom to a spatial bookmark created for this
exercise.
1. Click the View menu, point to Bookmarks, then click

West streams to set the current view to the edit area of
this exercise.

The map will display the following area:

3. Click the Target Layer drop-down arrow and click
StreamsSouth.
The StreamsNorth layer will be adjusted to match the
target layer, StreamsSouth.

4. Check the One link for each destination point check
box.

5. Click the Prevent duplicate links check box and click
OK.

3

5

4 1
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Adding displacement links

Displacement links define the source and destination
coordinates for an adjustment. In this exercise, you will
create multiple links using the Edge Match tool.
1. Click the Edge Match tool on the Spatial Adjustment

toolbar.

2. With the Edge Match tool active, drag a box around the
endpoints of the features.
The Edge Match tool will create multiple displacement
links based on the source and target features that fall
inside the box.

2

1

Displacement links now connect the source and target
features at their endpoints.
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Selecting features

Since edgematching only affects the exterior regions of the
layer, you must select the features you want to adjust.
1. Click the Edit tool on the Editor toolbar.

2. With the Edit tool active, drag a box around the features
that are to be edgematched, as shown below.

1

2

The participating features are now selected.
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Adding additional displacement links

1. Click the View menu, point to Bookmarks, then click
East streams.

Repeat the same steps used for creating links with the Edge
Match tool for the East streams portion of the data.
You will need to hold down the Shift key while you select
the stream features so the features from the West side stay
selected.

Examining the adjustment

You can examine how an adjustment will appear prior to
actually performing it with the Preview Window. You can
use the standard ArcMap Zoom and Pan tools to change the
display of the Preview Window.
1. Click the Spatial Adjustment menu and click Preview

Window to examine the adjustment.

The following window appears:

If the results are not acceptable, you can modify the
existing links to improve the accuracy of the adjustment.

1
1
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Performing the adjustment

The final step of the spatial adjustment process is to
perform the adjustment.
1. Click the Spatial Adjustment menu and click Adjust.

Since the Spatial Adjustment tool operates in an edit
session, you can use the Undo command to undo the
adjustment. Here is how the adjustment should appear:

Saving your edits

If you are satisfied with the results of the spatial
adjustment, you can stop editing and save your edits.
1. Click the Editor menu and click Stop Editing.

2. Click Yes to save your edits.

In this exercise, you learned how to set edgematch
properties, use the Edge Match tool to create displacement
links, and preview the adjustment.

1

1
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Exercise 9: Using the Attribute Transfer tool

The Attribute Transfer tool is used to transfer attributes
from features in a source layer to features in a target layer.
Source and target layers and the attributes to be transferred
are defined in the Attribute Transfer Mapping dialog box.
The Attribute Transfer tool is then used to interactively
transfer those attributes between features of the source and
target layers.
In this exercise, you�ll transfer the street name and type
from an existing street to a new street recently added to the
database.

Starting ArcMap and beginning editing

Before you can complete the tasks in this tutorial, you must
start ArcMap and load the tutorial data.
1. Double-click a shortcut installed on your desktop or use

the Programs list in your Start menu to start ArcMap.
2. Click the Open button on the Standard toolbar. Navigate

to the AttributeTransfer.mxd map document in the
Editor directory where you installed the tutorial data.
(C:\ArcGIS\ArcTutor is the default location.)

3. Click the Editor Toolbar button on the Standard toolbar
to add the Editor toolbar to ArcMap.

4. Click the Editor menu and click Start Editing.

2

3
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Adding the Spatial Adjustment toolbar

1. Click the View menu, point to Toolbars, then click
Spatial Adjustment to add the Spatial Adjustment
toolbar to ArcMap.

The Spatial Adjustment toolbar appears.

Setting the snapping environment

Before you transfer attributes, you should set your
snapping environment for your source and target layers.
This will ensure that you select the correct feature when
using the Attribute Transfer tool.

1

2

1

1. Click the Editor menu and click Snapping to display the
Snapping Environment dialog box.

2. Check the Edge check boxes next to the Streets and
NewStreets layers. Close the dialog box.
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Setting the source and target layers

The first step in the Attribute Transfer process is to set the
source and target layers. The Attribute Transfer Mapping
dialog box allows you to define these settings.
1. Click the Spatial Adjustment menu and click Attribute

Transfer Mapping.

2. Click the Source Layer drop-down arrow and click the
Streets layer.

3

2

1

3. Click the Target Layer drop-down arrow and click the
NewStreets layer.
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Mapping source and target fields

The next step is to specify which fields to use for the
attribute transfer. You will select a field in the source layer
and match it to a corresponding field in the target layer.
The Attribute Transfer tool will use these matched fields to
determine which data to transfer.
1. Click the NAME field in the Source Layer field list box.

2. Click the NAME field in the Target Layer field list box.

3. Click Add.

The fields are now added to the Matched Fields list box.
4. Repeat the same steps for the Type fields and click OK.

1

2

3
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Locating the adjust data

Spatial bookmarks are named extents that can be saved in
map documents. Creating a bookmark for areas that you
visit frequently will save you time.
You will now zoom to a spatial bookmark created for this
exercise.
1. Click the View menu, point to Bookmarks, then click

New streets to set the current view to the edit area of
this exercise.

When the display refreshes, you should see the
following area in your map:

1
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Identifying features for the attribute transfer

Prior to performing the attribute transfer, you will need to
verify the attributes of the source and target features. This
can be done using the Identify tool.
1. Click the Identify tool. The Identify dialog box appears.

2. Click the source feature indicated, as shown below.

Notice the NAME and Type field attributes. These
attribute values will be transferred to the target feature.

3. With the Identify tool still active, click the target
feature, as shown below.

1

2

3
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Using the Attribute Transfer tool

You will now use the Attribute Transfer tool to transfer the
source feature attributes to the target feature.
1. Click the Attribute Transfer tool on the Spatial

Adjustment toolbar.

2. Snap to an edge of the source feature, as shown below.

The Identify dialog box now displays information about
the target feature. Notice the NAME and Type fields;
attribute values for these fields will be transferred to the
target layer from the Streets layer.

2

1
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Verifying the results of the attribute transfer

Now that you have transferred the attributes from the
source feature to the target feature, it is a good idea to
verify that the target feature was updated with the proper
information.
1. Click the Identify tool.

2. Click the target feature.

3

4

1

2

3. Drag the link toward the target feature.

4. Snap to an edge of the target feature and click.
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Saving your edits

If you are satisfied with the results of the attribute transfer,
you can stop editing and save your edits.
1. Click the Editor menu and click Stop Editing.

2. Click Yes to save your edits.

In this exercise, you learned how to transfer attributes from
a source layer to a target layer.

The NAME and Type fields in the target feature should
reflect the new attributes:

Transferring attributes to multiple features

To transfer the attributes of a source feature to multiple
target features, hold down the Shift key while selecting the
target features.

1
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Exercise 10: Creating and editing annotation

Annotation is a way to store text to place on your maps.
With annotation, each piece of text stores its own position,
text string, and display properties. Dynamic labels, based
on one or more attributes of features, are the other primary
option for placing text on maps. If the exact position of
each piece of text is important to you, then you should
store your text as annotation. ArcGIS fully supports two
types of annotation: geodatabase annotation and map
document annotation. ArcGIS also supports the display and
conversion of other annotation types including ArcInfo
coverage annotation and CAD annotation.
In this exercise, you will convert some labels into
geodatabase annotation, place some unplaced annotation
features, and edit some annotation features.

Opening the exercise document

1. Start ArcMap.
2. Click File and click Open. Navigate to and open the

EditingAnno.mxd map document located in the Editor
folder where you installed the tutorial data
(C:\ArcGIS\ArcTutor is the default location).

This map shows roads and water features in Zion National
Park. Each feature layer has dynamic labels, and the
Streams, Major Roads, and Water Points layers have label
classes based on the layers� symbology. Label classes let
you create different labels for different types of features in
a given layer, so, for example, intermittent streams can be
given smaller labels than perennial streams.
Suppose you need to create an 8.5 x 11 inch map that
shows the named streams within the park. It is more

important to get the perennial streams labeled than the
intermittent ones, but your objective is to include as many
stream names as possible for the park area.

Viewing unplaced labels

Some of the streams could not be labeled due to space
constraints on the map. You�ll add the Labeling toolbar and
view the unplaced labels.
1. Click View, point to Toolbars, and click Labeling.

2. Click the View Unplaced Labels button.

The labels that could not be placed are displayed in red.

1

2
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It might be possible to fit these labels by adjusting the
size of the labels, changing the feature and label
weights, or making the map larger. However, for this
exercise, you will convert the labels to annotation and
place or delete the unplaced annotation.

3. Click the View Unplaced Labels button again to hide the
unplaced labels.

Next you�ll prepare to convert the labels to annotation.

Setting a reference scale

Annotation features have a fixed position and size, so when
you zoom in to the map they appear to get larger. Labels
are dynamically drawn according to their layer�s label
properties. If the map does not have a reference scale, they
are drawn at their specified font size regardless of the map
scale. To make labels behave more like annotation, you can
set a reference scale for the map. The labels will be drawn
with their specified font size scaled relative to the reference
scale. When converting labels to annotation, you should
specify a reference scale. If you do not, the current map
scale will be used as the reference scale for the annotation.
1. Type �170000� in the Map Scale box and press Enter.

2

2. In the ArcMap table of contents, right-click Layers,
point to Reference Scale, and click Set Reference Scale.

You can also view and change the reference scale for the
data frame using the General tab of the Data Frame
Properties dialog box.

Now if you zoom in or out, the labels will become
correspondingly larger or smaller. You�re ready to convert
these labels to annotation.

Converting labels to annotation

Annotation can be stored in a map document or in feature
classes in a geodatabase. You will convert these labels to
annotation stored in a geodatabase.
1. In the ArcMap table of contents, right-click Layers and

click Convert Labels to Annotation.

1
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The Convert Labels to Annotation dialog box allows
you to specify what kind of annotation to create from
the labels, which features to create annotation for, and
where the annotation will be stored.

ArcView licensed seats of ArcMap can view feature-linked
annotation, but they cannot create it or edit datasets that
contain it. If you have an ArcView license, the Feature
Linked column of check boxes will be unavailable. In this
exercise, you will create standard annotation features. Skip
the next step if you have an ArcView license.

Convert Labels to Annotation dialog box with an ArcEditor or ArcInfo
license of ArcMap. Annotation will be feature-linked by default.

2. Uncheck the check boxes in the Feature Linked column.

Small folder icons, the Browse buttons, appear beside
the annotation feature class names as you uncheck the
Feature Linked check boxes. Feature-linked annotation
must be stored with the feature class that it is related to
in the geodatabase. Standard annotation feature classes
can be stored in other geodatabases; after unchecking
the boxes, you have the option to specify a new location
for your annotation. Standard annotation feature classes
will be stored in the same dataset as their source feature
class by default. If a feature layer on the map was based
on a shapefile or coverage feature class, the Browse
button would have been visible and you would need to
browse to a geodatabase to store the new annotation
feature class.

2
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3. Verify that the box to Convert unplaced labels to
unplaced annotation is checked.

This will give you a chance to manually place the
annotation for the features that could not be labeled.

4. Click Convert.
The labels are converted to annotation. The process
should take less than a minute, though the speed will
depend on your computer. When the annotation feature
classes are created, they are added to ArcMap.

3 4

Each layer�s label classes will be stored as separate
annotation classes within a single annotation feature class.
For example, the two label classes for streams will become
two annotation classes, called Intermittent and Perennial,
within the StreamsAnno annotation feature class. These
annotation classes can be turned on and off independently,
and they can have their own visible scale ranges.

Preparing to place unplaced annotation

Now that the labels have been created, you will add the
Editor and Annotation toolbars, switch to data view in
ArcMap, and start an edit session.
1. If the Annotation toolbar is not visible, click View, point

to Toolbars, and click Annotation. If the Editor toolbar
is not visible, add it using the same method.

1
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While you can edit in layout view, the display
performance is better in data view.

2. Click View and click Data View.

3. Click Editor and click Start Editing.

4. Click the Unplaced Annotation Window button on the
Annotation toolbar.

The Unplaced Annotation Window appears. You can
resize it, dock it to the ArcMap window, or leave it
floating.
The Unplaced Annotation Window lets you view
unplaced annotation features in a table that can show all
the unplaced annotation in the annotation feature classes
on your map. You can filter the table to show annotation
for a specific annotation class and choose whether to
show annotation for the whole extent of the data or for
the current visible extent. You can sort the table
alphabetically by the unplaced annotation�s text content
or annotation class by clicking the Text or Class column
headings.

2
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5. Check the Draw check box.

The Draw check box lets you view the unplaced
annotation features on the map.

6. Click Search Now.
A number of annotation features are listed in the table.
If you scroll down the table, you can see there are
unplaced annotation features from several annotation
classes represented.

You can also see some new annotation features outlined
in red on the map. You see these unplaced annotation
features because the Draw check box is checked.
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7. Click the Edit Annotation tool.

8. Click the map, press and hold down the Z key, and click
and drag a box around the small cluster of unplaced
annotation features at the east side of the park.

The Z key is the editing shortcut key to zoom in.
The Hillshade background layer has a visible scale range;
when you zoom in closer than 1:85,000, it is no longer
displayed. Setting a visible scale range is also a good idea
for annotation feature classes, as they are most useful
within the range of scales where they are legible. There is
no need to spend time or�especially for multiuser
geodatabases�network and database resources drawing
annotation features when they cannot be read. You can set a
visible scale range for a layer in ArcMap, or you can
change the properties of the annotation feature class itself

8

1

in ArcCatalog. The second method has the advantage that
the annotation feature class will always be drawn within its
visible scale range when it is added to a map.

Placing an unplaced annotation feature

Now that you�ve zoomed in to the cluster of unplaced
annotation in the east side of the park, you�re ready to start
placing the unplaced annotation features.
1. Click Search Now.

2. Right-click Cave Canyon in the Text column and click
Place Annotation.

2
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The Cave Canyon annotation feature is placed. It is
selected, so it has a blue outline instead of a red outline.

The annotation feature is straight and placed parallel to a
segment of the stream feature. The other stream annotation
features curve to follow the streams, so you will make this
newly placed annotation feature follow the stream.

Following a feature

You can make an annotation feature follow a line feature or
the boundary of a polygon feature. The Follow Feature
Options dialog box allows you to specify how annotation
will behave when it follows a feature.
1. Right-click the Cave Canyon annotation feature, point to

Follow, and click Follow Feature Options.
The Follow Feature Options dialog box appears.

1

2. Click Curved.

3. Click the Side cursor is on button to constrain the
placement of the annotation.

4. Type �150� in the Offset from feature text box. The
annotation will be offset 150 meters from the stream.

5. Click OK.

4 5
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6. Move the pointer over the stream feature just east of the
Cave Canyon annotation feature. With the pointer
slightly to the left of the stream, right-click and click
Follow This Feature.

The stream feature will flash, and the annotation feature
will bend to follow the stream. If you click too near the
road feature, the annotation may follow the road. While
the Cave Canyon annotation feature is still selected, you
can fix this by repeating the last step. The selected
annotation feature will follow any line feature that you
right-click and tell it to follow using the Edit Annotation
tool.

7
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7. Place the pointer over the middle of the Cave Canyon
annotation feature. The pointer will change to the four-
pointed Move Annotation pointer.

8. Click and drag the Cave Canyon annotation feature
along the stream feature until it is between the park
boundary and the road. It will slightly overlap each of
these features. Press the L key as you drag the
annotation to flip its reading direction.

9. Place the pointer over the red triangle on the edge of the
Cave Canyon annotation feature. The pointer will
change to the two-pointed Resize Annotation pointer.

10. Click and drag the resize handle toward the middle of
the annotation feature. The feature will shrink as you
drag it. Resize the feature until it fits between the park
boundary and the road.

6
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You�ve placed an annotation feature, made it follow
another feature, and resized it with the Edit Annotation
tool. The Edit Annotation tool also allows you to make
other edits to annotation features.

Stacking and rotating annotation

Now that you�ve placed the annotation feature from the
StreamsAnno feature class, you�ll place the other nearby
annotation features.
1. In the Unplaced Annotation window, right-click Grotto

Springs and click Pan to Annotation.

2. Press the Spacebar.
The Grotto Springs annotation feature is placed.
The Spacebar is the Unplaced Annotation window
shortcut key to place a selected annotation feature.

3
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3. Right-click the map and click Stack.

The Grotto Springs annotation feature is split at the
space in the text, and the word Grotto is placed above
the word Springs.

4. Move the pointer over the middle of the Grotto Springs
annotation feature. The pointer will change to the four-
pointed Move Annotation pointer. Click the middle of
the Grotto Springs annotation feature and drag it to the
southwest, so it does not cover the Hidden Canyon
annotation feature.

1
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5. In the Unplaced Annotation window, click FLOOR OF
THE VALLEY RD, and press the P key.

The P key is the Unplaced Annotation window shortcut
key to pan to a selected annotation feature.

6. Click the map, press and hold down the X key, and click
near the unplaced FLOOR OF THE VALLEY RD
annotation feature.

The X key is the shortcut key to zoom out.

7
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7. Right-click FLOOR OF THE VALLEY RD and click
Place Annotation.

8. Click the middle of the FLOOR OF THE VALLEY RD
annotation feature with the four-pointed Move
Annotation pointer, and drag it to the southwest, until
the south end of the annotation feature is near the
intersection of Floor of the Valley Rd and the road that
branches off to the east, State Highway 9.

6
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9. Move the pointer over the blue, wedge-shaped rotate
handle on the northeast corner of the FLOOR OF THE
VALLEY RD annotation feature until the pointer
becomes the Rotate pointer. Click the corner and drag it
counter-clockwise until the annotation feature follows
the general trend of the road.

10. Right-click the FLOOR OF THE VALLEY RD
annotation feature and click Stack.

1 2

You�ve placed, moved, stacked, and rotated annotation
features with the Edit Annotation tool. Next you�ll create
new annotation and delete annotation.

Creating and deleting annotation

Suppose you decide that the intersection of Floor of the
Valley Rd and State Highway 9 is inadequately annotated.
You�ll create a new annotation feature for State Highway 9
and place it near the intersection.
1. On the Editor toolbar, click the Sketch tool.

When the Edit Annotation tool is active, you can press
the E key to quickly switch between Sketch, Edit, and
Edit Annotation tools.

2. Verify that the Task drop-down list says Create New
Feature. If necessary, click the drop-down arrow and
click Create New Feature.
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3. Click the Target drop-down list and point to
Major_RoadsAnno. You have the option to choose an
annotation class. Click the plus sign to expand
Major_RoadsAnno and click Roads.

4. Verify that the symbol has switched to Roads when you
made the Roads annotation class the target for your
edits.

5. Press the Esc key to return focus to the Sketch tool.
When you click the drop-down lists, the Sketch tool
loses focus. Pressing the Esc key returns focus to the
tool so the shortcut key you use in the next step will
work.

6. Move the pointer over the road feature that branches off
to the east from the intersection with Floor of the Valley
Rd. Press Ctrl+W.

The Ctrl+W shortcut takes the label expression of the
first visible and selectable feature that you are pointing
at and adds it to the Text box on the Annotation toolbar.
When you use Ctrl+W while editing a feature-linked
annotation class, it uses the expression of the annotation
class to derive the text and will only derive the text from
a feature in the linked feature class.
The Text box on the Annotation toolbar should say
STATE HWY 9. If it says ZION NATIONAL PARK or
Clear Creek, move the pointer over the road feature and
press Ctrl+W again.
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7. Click above the road to place the new annotation
feature.

Because the construction method was Horizontal, one
click placed the annotation feature.
The pointer is still in Construct feature mode, and it
says STATE HWY 9. If you needed to annotate more
features, you could click somewhere else on the map to
add another piece of annotation with the same text, or
you could move the pointer over another feature and
press Ctrl+W to pick up new text from its label
expression. You could also type new text directly into
the Text box on the Annotation toolbar. In Construct
feature mode, the A key is a shortcut that lets you set the
focus to the Text box, so you can type new text without
clicking in the box.
Most of the road annotation follows the road features.
You�ll use a different construction method to create a
new annotation feature that follows the road.

8. Click the Construction drop-down list and click Follow
Feature.

9. Click the road feature, then move the pointer along the
road. The road should be highlighted, and the annotation
feature should move along the road as you move the
pointer. Click again to finish the annotation sketch.

10. Press the E key to switch to the Edit tool pointer.
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11. Click the horizontal STATE HWY 9 annotation feature
that you created and press the Delete key.

The horizontal annotation feature is deleted.
You could continue to place the unplaced annotation,
edit annotation, create new annotation features, and
delete unwanted annotation until the map suits your
needs. This annotation is stored in geodatabase
annotation feature classes, each of which can be reused
on other maps.

12. Click Editor and click Save Edits, then click Editor and
click Stop Editing.

In this exercise, you created annotation from labels with
multiple label classes, placed annotation features derived
from labels that did not fit on the map, stacked and rotated
annotation using the Edit Annotation tool, resized
annotation features, made existing and new annotation
features follow a given linear feature, and set the text string
for a new annotation feature.
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In the first two exercises, you learned how to use the edit
sketch and sketch tools to create new features. There are a
lot of additional methods for creating features that were not
touched upon in these exercises.
In addition to digitizing new features using the mouse, you
learned how to use a digitizer puck and tablet to capture
data from paper maps. Exercise 3 showed how you can
attach a paper map to your digitizing tablet, register the
paper map to the coordinate space of your GIS database,
and add features using the puck.
In Exercise 4, you learned how easy it is to modify the
shape of existing features. You copied and pasted buildings
from a CAD file into your GIS database; you also moved,
rotated, and scaled the buildings to match a parcel
subdivision using some of the editing tools in ArcMap.
Once the buildings were properly placed, you used the
Extend/Trim and Modify Feature edit tasks to connect
water service lines to the side of each building.
You can edit multiple features at the same time in ArcMap
and ensure that the boundaries between them are
consistent. In Exercise 5, you learned how to create a map
topology and use the Topology Edit tool and two basic
editing tools to edit several features at once while
maintaining contiguity along their shared edge.
In Exercise 6, you learned how to update your existing data
with features in a CAD drawing file using the Load Objects
wizard. You defined a query based on the lot line CAD
layer type and loaded only those features into your target
layer.
Whether importing CAD data, using a digitizer to capture
features from paper, or editing the shared boundaries

between polygon features, ArcMap provides the tools you
need to edit your data quickly and easily.
In Exercise 7, you learned how to use a geodatabase
topology and the topology error management tools in
ArcMap to clean up data and create new features.
In Exercise 8, you learned how to use the Spatial
Adjustment tool to transform, rubbersheet, and edgematch
data. You created displacement links to define the source
and destination locations and set adjustment properties.
In Exercise 9, you learned how to use the Spatial
Adjustment tool to transfer the attributes from one feature
to another.
In Exercise 10, you learned how to convert labels to
annotation in a geodatabase, place unplaced annotation,
and edit annotation features.
To learn more about these and other topics, see the ArcGIS
Desktop Help.
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